Performance Management & Quality
Improvement Plan Template User &
Resource Guide

This document provides guidance for using the governmental public health department Performance
Management & Quality Improvement Plan template developed by the Center for Public Health Practice
at the Ohio State University College of Public Health (CPHP). The template is based on the requirements
of the Public Health Accreditation Board (PHAB) Standards & Measures, v 1.5, Measure 9.2.1 A.

This template is intended as guidance only. Users are expected to adapt the template so that it follows
agency branding guidelines and otherwise meets their needs in content.

The Quality Improvement Plan template was originally created in 2013 through a collaborative process
with local and state governmental public health representatives in Ohio. It was then revised in 2014 to
reflect version 1.5 of the PHAB guidance for Measure 9.2.1 A. Revisions to this most current version
(2018), referred to as v 1.5b, are primarily to format, order of contents, expanded resources, and —
perhaps most significantly — the addition of options for strengthening connections between an
organization’s overall performance management (PM) and quality improvement (Ql) efforts.

Using the Template

Guidance for using this template follows:

e The template uses a basic Microsoft Word format. Under the ‘Home’ tab, use the ‘Styles’ ribbon
to change the default heading or text style, and use the ‘Design’ tab to change the color scheme.

e The sections and appendices within the template are intended to be edited to further customize
the document (for instance, you may wish to call the Training section Workforce Development).
You may also wish to add sections or appendices.

e Basic text within the template is in three colors:

o Black and Blue: Standard headings and language that can be left as is or modified.
Regardless of your choice, be sure that the document reflects your agency’s preferences
and “voice”.

o Red: Instructions for completing each section, and in some instances, example text. All
red text should be deleted or edited. After writing is complete, change the red text to
reflect the selected color scheme.

This template has been developed by the Center for Public Health Practice at the Ohio
State University College of Public Health. Current revisions were made possible by the

THE OHIO STATE UNIVERSITY Ohio Department of Health with funding from the Ohio Department of Higher Education
COLLEGE OF PUBLIC HEALTH as part of the Ohio Local Public Health Accreditation Support Project (December 2018).

Use of this template does not guarantee or imply compliance with PHAB Accreditation Standards & Measures, v 1.5.
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Examples are provided in blue textboxes. They are suggestive only and not
all-inclusive. Agencies are encouraged to use the examples for reference, but
adapt each section with information and materials that are applicable to
their agency. Examples address quality improvement plan requirements, not
performance management requirements.

e Guidance specific to the connections of this plan to overall agency performance management
appears in italics within each section, if applicable.

e Examples of some supportive documentation (such as team charters, PDSA worksheet,
storyboard, etc.) are available as separate, editable documents. Users should refer to the CPHP
website for available tools.

e The Table of Contents is created using an automatically generated format, however headings
and page numbers must still be manually added. To add an automatically populated table or to
remove this feature all together, use the ‘References’ tab, ‘Table of Contents’ ribbon.

e There are page breaks set at the end of some sections of the template. These may be deleted or
changed as desired using the ‘Layout’ tab, ‘Page Setup’ ribbon.

Disclaimer

This template has been designed to address the documentation requirement for (version 1.5) Public
Health Accreditation Board Measure 9.2.1 A: Established quality improvement program based on
organizational policies and direction, and to support Measure 9.2.2 A: Implemented quality
improvement activities. The addition of performance management language also supports Measures
9.1.2,9.1.3, and 9.1.5, but will not fully address these requirements. Users should become thoroughly
familiar with current standards, associated measures, and required documentation. Use of this template
does not imply or guarantee acceptance of the final product as meeting PHAB requirements.

Plan and Template Considerations

Before use, it is recommended that users familiarize themselves with this User & Resource Guide and
the template itself. Other considerations before beginning to write follow:

e The template was created with several purposes in mind. The purpose of supporting agencies in
their quest for accreditation has already been stated. Additionally, this plan template was
designed to assist agencies in educating their employees, Boards, and especially new PM/Ql
committee/council members about their roles, expectations, and the agency’s aspirations relative
to quality. Because of this dual purpose, agencies may find it to be more descriptive than they
desire. If this is the case, simply edit the document accordingly.

e Persons responsible for writing this plan should have at least a basic understanding of quality
improvement and performance management. Resources for training can be found at the end of
this guide.

e The support of leadership cannot be overestimated - be sure to keep leadership abreast of plan
development, communicate regularly, and help them to communicate about performance/quality
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efforts and the plan. If your leadership (including a Board or governance) does not yet fully
understand or support this work, consider how this might be addressed early in the process.

e Quality efforts are part of an agency’s overall performance management system and should also
align with the agency’s strategic plan and workforce development plan. Make sure these
documents and efforts support one another; use cross references among plans as applicable.

e Anagency’s plan should be unique and written to meet its needs. An agency should not use this
template solely for the purpose of “checking a box” that is required by PHAB —a PM/QI Plan
should be a fundamental guide for moving toward a culture of quality. (The plan should state how
a department does Ql, not what you think an accreditor wants to hear.)

e Some organizations create a single document that includes the overall performance management
policy/system description (See PHAB Standard 9.1.2 A and 9.1.3 A) and the QI Plan. Whether the
performance management system description and QI Plan are separate or co-existing is up to

individual departments. Text that is not applicable should be removed.

e Examples that appear throughout the template are offered to illustrate Ql activities that might
apply to organizations of different sizes who are in beginner or intermediate phases of QI
maturity. As agencies gain experience and efforts increase in sophistication, so should their plans.
In all cases, users should consider what is logical, practical, and applicable to their organization.

e Examples are not intended to reflect broader organizational performance goals, objectives,
targets, etc., that are part of a performance management system. Users can expect that separate
performance management documentation (spreadsheet, software tool, report, etc.) will be
needed to demonstrate PHAB requirements.

And some final words of wisdom and tips:

e If your organization has a particular format or nomenclature for plans, policies or official
documents, adapt the template to be consistent.

e The quality of a Ql plan is not necessarily associated with its length. Template users should be
descriptive, yet succinct.

e Consider placing sections of the plan that will be updated frequently in the appendix rather than
within the body of the plan itself. This will make regular updates easier.

e Before considering the written plan final, check the content against the PHAB Standards &
Measures to assure that you have adequately addressed all of the necessary components.

e Proofread your plan to assure that: it says what you intend it to, it is appropriately branded,
formatting is consistent, and red font is deleted or changed.

Contact and Feedback

For additional information or to offer feedback, please contact the Center for Public Health Practice at
614-292-2291, or cph-practice@osu.edu.
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Quality Improvement Resources

There are a growing number of resources to support quality improvement in public health. The following table lists some of those resources, both state and
national. The list is in no way exhaustive. Resources are listed in alphabetical order. In addition to those included here, consider local and regional resources,
such as community colleges, hospitals (who have a history of implementing quality improvement initiatives), and academic institutions near your jurisdiction.

Other resources, such as templates and PDSA tools are available as separate, and editable documents. Check the CPHP website for these resources.

Resource

Location & Description

American Society for Quality

(AsQ)

http://asq.or
A membership organization whose mission is: to increase the use and impact of quality in response to the diverse
needs of the world. Training, resources, certifications, and learning communities.

Association of State and
Territorial Health Officials
(ASTHO)

http://www.astho.org

Membership organization for state health officials. Resources, links to Ql and performance management tools.
http://www.astho.org/Accreditation-and-Performance/Quality-Improvement/QI-Plan-
Toolkit/Home/?terms=quality+toolkit

Ql Plan toolkit.

Center for Public Health Practice,
The Ohio State University College
of Public Health (CPHP)

http://cph.osu.edu/practice

Live and online competency-based training and other organizational development resources, including Ql Plan,
Workforce Development Plan, and Competency-based Job Description templates. Consultation services.
https://osupublichealth.catalog.instructure.com/

Learning management system; searchable catalog of training opportunities, including online CQl modules.
https://www.publichealthlearning.com/login/index.php

No cost, introductory, online performance management learning modules (developed collaboratively).
https://u.osu.edu/cphpaccreditationproject/public-health-accreditation/

Ohio Local Public Health Accreditation Support Project resources, including Ql & performance management
tools/resources.

https://u.osu.edu/pmtoolkit/

Performance Management in Public Health toolkit: training & worksheets, tips & examples, notes from
practitioners.

Centers for Disease Control and
Prevention (CDC)

http://www.cdc.gov/stltpublichealth/performance/
Concepts, resources, and links about quality improvement and performance management.

Institute for Healthcare
Improvement (IHI)

http://www.ihi.org/Pages/default.aspx
Quality tools and training on Ql in healthcare with applicability to public health. Utilizes PDSA.

Journal of Public Health
Management and Practice Direct
(JPHMP Direct)

https://iphmpdirect.com/
“An online community for advances in public health.” Publications, tools, infographics, cases, etc.; some features
include quality improvement, accreditation, performance management, and public health infrastructure topics.
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Resource

Location & Description

LeanOhio

https://www.youtube.com/LeanOhio
LeanOhio YouTube page with instructional videos.

Michigan Public Health Institute
(MPHI)

https://www.mphiaccredandgi.org/embracing-quality-in-public-health/gi-guidebook/

Embracing Quality in Public Health: A Practitioner’s Quality Improvement Guidebook (2012).
https://www.mphiaccredandgi.org/embracing-quality-in-public-health/pmgi-primer/

Embracing Quality in Public Health: A Practitioner’s Performance Management Primer (online training).

Minnesota Department of Health

http://www.health.state.mn.us/qualityimprovement/
Many tools and resources geared toward public health.

National Association of County
and City Health Officials
(NACCHO)

http://www.naccho.org/topics/infrastructure/accreditation/quality.cfm

Ql resources, training, templates.
http://www.naccho.org/topics/infrastructure/accreditation/qi-culture.cfm

Roadmap to a Culture of Quality Improvement and Organizational Culture of Quality Self-Assessment Tool.

National Network of Public Health
Institutes (NNPHI)

https://nnphi.org/

Tools, resources, conferences, and practice communities with focus on accreditation and performance
improvement, including: Public Health Improvement Training (PHIT), Open Forum for Quality Improvement and
Innovation, and Public Health Performance Improvement Network (phPIN).

NIATx

https://niatx.net/Home/Home.aspx
Simple process for improvement geared to behavioral health but applicable more broadly. Training & tools.

Public Health Performance
Improvement Network (phPIN)

https://nnphi.org/relatedarticle/public-health-performance-improvement-network-phpin/
Peer exchange & learning community for performance management practitioners.

Public Health Quality
Improvement Exchange (PHQIX)

https://www.phqix.org/
Online community for learning and sharing about quality in public health. Searchable; forum for online dialogue and
sharing (uploading) example documents (including example QI Plans).

Public Health Accreditation Board
(PHAB)

http://www.phaboard.org/
Non-profit organization that oversees public health agency accreditation. Accreditation standards, measures, and
requirements; training, resources, accreditation.

Public Health Foundation (PHF)

http://www.phf.org/focusareas/pmaqi/pages/default.aspx
Performance management and quality improvement tools.
http://www.phf.org/resourcestools/Pages/PIMs competencies.aspx
Core Competencies for Performance Improvement Managers.

TRAIN/Ohio TRAIN

www.train.org; www.ohiotrain.org
Searchable public health-related continuing education opportunities offered by affiliates from across the country.

University of Minnesota

https://webapps-prd.oit.umn.edu/pcas/viewCatalogProgram.do?programID=7580&strm=1153&campus=UMNTC
Public Health Certificate in Performance Improvement.
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Resource Location & Description
Performance Management e Balanced Scorecard. Structure for performance management across four perspectives: Customer, Internal
Frameworks Process, Financial and Employee Learning & Growth. (Kaplan & Norton, 1992)

e Baldrige Performance Excellence Program. Framework focusing on Leadership; Strategy; Customers;
Measurement, Analysis and Knowledge Management; Workforce; Operations; and Results. Includes self-
assessment. (https://www.nist.gov/baldrige)

e Five Pillars of Excellence. Framework of performance based on People, Quality, Service, Growth, and Finance.
(Studer, 2007)

e Management Systems International. 6-step framework: Define Results, Identify Performance Indicators,
Develop a Performance Monitoring Plan, Measure, Use, and Improve. (See
https://u.osu.edu/cphpaccreditationproject/public-health-accreditation/)

e Public Health Foundation Turning Point. Performance management system framework and tools; includes self-
assessment tool. (http://www.phf.org/resourcestools/Pages/Turning Point Project Publications.aspx)
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